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Construction of a road embankment [ADV]

The construction of an embankment on soft soil with a high groundwater level leads to an increase in pore
pressure. As a result of this undrained behaviour, the effective stress remains low and intermediate
consolidation periods have to be adopted in order to construct the embankment safely. During consolidation the
excess pore pressures dissipate so that the soil can obtain the necessary shear strength to continue the
construction process.
This tutorial concerns the construction of a road embankment in which the mechanism described above is
analysed in detail. In the analysis two new calculation options are introduced, namely a consolidation analysis
and the calculation of a safety factor by means of a safety analysis (phi/c-reduction). It also involves the
modelling of drains to speed up the consolidation process.
Objectives

• Modelling drains
• Consolidation analysis
• Change of permeability during consolidation
• Safety analysis (phi-c reduction)
Geometry

The figure below shows a cross section of a road embankment.
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Figure 1: Situation of a road embankment on soft soil

Create a new project
The embankment is 16 m wide. The slopes have an inclination of 1: 3. The problem is symmetric, so only one half
is modelled (in this case the right half is chosen). A representative section of 2 m is considered in the project. The
embankment itself is composed of loose sandy soil. The subsoil consists of 6 m of soft soil. The upper 3 m of this
soft soil layer is modelled as a peat layer and the lower 3 m as clay. The phreatic level is located 1 m below the
original ground surface. Under the soft soil layers there is a dense sand layer of which 4 m are considered in the
model.

PLAXIS 2 PLAXIS 3D - Tutorial Manual - Construction of a road
embankment [ADV]



1. Start the Input program and select Start a new project from the Quick select dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. Keep the default units and set the model dimensions to

a. xmin = 0 and xmax = 60
b. ymin = 0 and ymax = 2.

Define the soil stratigraphy
The soil layers comprising the embankment foundation are defined using a borehole. The embankment layers
are defined in the Structures mode.
1. Click the Create borehole button  and create a borehole at (0 0 0).

The Modify soil layers window pops up.
2. Define three soil layers as shown in Figure 43 (on page 3).
3. The water level is located at z = -1 m. In the borehole column specify a value of -1 to Head.

Figure 2: Soil layer distribution

Create and assign the material data sets
The material properties for the data sets are shown in the table below.

Construction of a road embankment [ADV]
Define the soil stratigraphy
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Table 1: Material properties of the road embankment and subsoil

Parameter Name Embankment Sand Peat Clay Unit

General

Material model Model Hardening
Soil

Hardening
Soil

Soft Soil
model

Soft Soil
model -

Type of material behaviour Type Drained Drained Undrained
(A)

Undrained
(A) -

Soil unit weight above
phreatic level γunsat 16 17 8 15 kN/m3

Soil unit weight below
phreatic level γsat 19 20 12 18 kN/m3

Initial void ratio einit 0.5 0.5 2.0 1.0 -
Parameters

Modified compression index λ* - - 0.15 0.05 -
Modified swelling index κ* - - 0.03 0.01 -
Secant stiffness in standard
drained triaxial test E50

ref 2.5 · 104 3.5 · 104 - - kN/m2

Tangent stiffness for primary
oedometer loading Eoed

ref 2.5· 104 3.5 · 104 - - kN/m2

Unloading / reloading
stiffness Eur

ref 7.5· 104 1.05 · 105 - - kN/m2

Power for stress-level
dependency of stiffness m 0.5 0.5 - - -

Cohesion (constant) cref' 1.0 0.0 2.0 1.0 kN/m2

Friction angle φ' 30 33 23 25 °
Dilatancy angle ψ 0.0 3.0 0 0 °
Advanced: Set to default Yes Yes Yes Yes Yes -
Groundwater

Data set - USDA USDA USDA USDA -

Model - Van
Genuchten

Van
Genuchten

Van
Genuchten

Van
Genuchten -

Construction of a road embankment [ADV]
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Parameter Name Embankment Sand Peat Clay Unit

Soil type - Loamy sand Sand Clay Clay -
> 2μm - 6.0 4.0 70.0 70.0 %
2μm - 50μm - 11.0 4.0 13.0 13.0 %
50μm - 2mm - 83.0 92.0 17.0 17.0 %

Use defaults - From data
set

From data
set None From data

set -

Horizontal permeability (x-
direction) kx 3.499 7.128 0.1 0.04752 m/day

Horizontal permeability (y-
direction) ky 3.499 7.128 0.1 0.04752 m/day

Vertical permeability kz 3.499 7.128 0.05 0.04752 m/day
Change in permeability ck 1 · 1015 1 · 1015 1.0 0.2 -
Interfaces

Interface strength - Rigid Rigid Rigid Rigid -
Strength reduction factor
inter. Rinter 1.0 1.0 1.0 1.0 -

Initial

K0 determination - Automatic Automatic Automatic Automatic -
Over-consolidation ratio OCR 1.0 1.0 1.0 1.0 -
Pre-overburden pressure POP 0.0 0.0 5.0 0.0 kN/m2

Note:

The initial void ratio (einit) and the change in permeability (ck) should be defined to enable the modelling of a
change in the permeability due to compression of the soil. This option is recommended when using advanced
models.

1. Click the Materials button .
2. Create soil material data sets according to Table 12 (on page 4) and assign them to the corresponding layers

in the borehole (Figure 43 (on page 3)).
3. Close the Modify soil layers window and proceed to the Structures mode to define the structural elements.

Construction of a road embankment [ADV]
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Definition of embankment and drains
The embankment and the drains are defined in the Structures mode. To define the embankment layers:
1.  Reorientate the model such that the front view is displayed by clicking the corresponding button in the

toolbar.
2.  Create a surface by defining points at (0 0 0), (0 0 4), (8 0 4) and (20 0 0).
3.  Create a line passing through (0 0 2) and (14 0 2) to define the embankment layers.
4.

 Select both the created line and surface by keeping the <Ctrl> key pressed while clicking them in the
model.

5.  Click the Extrude object button. Assign a value of 2 to the y-component of the extrusion vector as shown
in the figure below and click Apply.

Figure 3: Extrusion window
6. Delete the surface and the line with its corresponding points that were created before the extrusion.
7. Right-click the volume created by extrusion and select the menu item Soil_4 > Set material > Embankment.
In this project the effect of the drains on the consolidation time will be investigated by comparing the results
with a case without drains. Drains will only be active for the calculation phases in the case with drains.
Drains are arranged in a square pattern, having a distance of 2 m between two consecutive drains in a row (or
column). Only one row of drains will be considered in this tutorial. To create the drain pattern:
1.

 Click the Create hydraulic conditions button in the side toolbar.
2.  Click the Create line drain button in the appearing menu. Define a line drain in the model between

points (1 1 0) and (1 1 -6).
3.  Click the Create array button to define the drain pattern.
4. In the Create array window select the menu item Shape > 1D, in x direction in the drop-down menu and

specify the pattern as shown in the figure below.

Construction of a road embankment [ADV]
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Figure 4: Settings of the drain pattern

The model geometry is shown in the following figure:

Figure 5: Model geometry

Generate the mesh

1. Proceed to the Mesh mode.
2. Select all volumes, including the embankment and in the Selection explorer set the Coarseness factor to 0.3.
3.  Click the Generate mesh button. Set the element distribution to Coarse.
4. View the generated mesh.
The resulting mesh is shown below.

Construction of a road embankment [ADV]
Generate the mesh
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Figure 6: The generated mesh

Define the calculation
The embankment construction process will be considered twice. In the first calculation the drains will not be
considered.

Initial phase

In the initial situation the embankment is not present. Therefore, the corresponding soil volumes are deactivated
in the initial phase. The K0 procedure can be used to calculate the initial stresses. The initial water pressures are
fully hydrostatic and based on a general phreatic level defined by the Head value assigned to the boreholes. For
the Initial phase, the Phreatic option is selected for the pore pressure calculation type and the Global water
level is set to BoreholeWaterlevel_1 corresponding to the water level defined by the heads specified for the
boreholes.
The boundary conditions for flow can be specified in the Model conditions subtree in the Model explorer. In the
current situation the left vertical boundary (Xmin) must be closed because of symmetry, so horizontal flow
should not occur. The bottom is open because the excess pore pressures can freely flow into the deep and
permeable sand layer. The upper boundary is obviously open as well. The view of the GroundwaterFlow
subtree after the definition is given in the figure below.

Construction of a road embankment [ADV]
Define the calculation
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Figure 7: Boundary conditions for groundwater flow

Consolidation analysis

A consolidation analysis introduces the dimension of time in the calculations. In order to correctly perform a
consolidation analysis a proper time step must be selected. The use of time steps that are smaller than a critical
minimum value can result in stress oscillations. The consolidation option in PLAXIS 3D allows for a fully
automatic time stepping procedure that takes this critical time step into account. Within this procedure there are
three main possibilities for the Loading type parameter:
• Consolidate for a predefined period, including the effects of changes to the active geometry (Staged

construction).
• Consolidate until all excess pore pressures in the geometry have reduced to a predefined minimum value

(Minimum excess pore pressure).
• Consolidate until the soil has reached a specified degree of consolidation (Degree of consolidation).

Consolidation process - No drains

The embankment construction is divided into two phases. After the first construction phase, a consolidation
period of 30 days is introduced to allow the excess pore pressures to dissipate. After the second construction
phase another consolidation period is introduced from which the final settlements may be determined.
To define the calculation phases, follow these steps:

Construction of a road embankment [ADV]
Define the calculation
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Phase 1
1.  Click the Add phase button to introduce the first construction phase.
2.  In the General subtree select the Consolidation option in the Calculation type drop-down menu.
3.  The Loading type is by default set to Staged construction. This option will be used for this phase.
4.  The Phreatic option is automatically selected for the pore pressure calculation type. Note that the global

water level for a calculation phase can be defined in the Water subtree available under the Model
conditions in the Model explorer.

5. Specify a value of 2 days to the Time interval and click OK to close the Phases window.
6. In the Staged construction mode activate the first part of the embankment.

Phase 2
The second phase is also a Consolidation analysis. In this phase no changes to the geometry are made as only a
consolidation analysis to ultimate time is required.
1.  Click the Add phase button to introduce the next calculation phase.
2.  Define the calculation type as Consolidation.
3. Specify a value of 30 days to the Time interval. The default values of the other parameters are used for this

phase.

Phase 3
1.  Click the Add phase button to introduce the next calculation phase.
2.  Define the calculation type as Consolidation.
3. Specify a value of 1 day to the Time interval. The default values of the other parameters are used.
4. In the Staged construction mode activate the second part of the embankment.

Phase 4
The fourth phase is a Consolidation analysis to a minimum excess pore pressure.
1.  Click the Add phase button to introduce the next calculation phase.
2.  Define the calculation type as Consolidation.
3.  Select the Minimum excess pore pressure option in the Loading type drop-down menu. The default

value for the minimum pressure (|P-stop| = 1.0 kN/m2) as well as the default values for other parameters are
used.

The definition of the calculation phases is complete.

Execute the calculation

Construction of a road embankment [ADV]
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1.  Before starting the calculation, click the Select points for curves button and select the following points:
As the first node, select the toe of the embankment at (20 0 0). The second node will be used to plot the
development (and decay) of excess pore pressures. To this end, a point somewhere in the middle of the soft
soil layers is needed, close to (but not actually on) the left boundary (e.g. (0.7 0 -3)).

2.  Start the calculation.
During a consolidation analysis the development of time can be viewed in the upper part of the calculation info
window. In addition to the multipliers, a parameter Pmax occurs, which indicates the current maximum excess
pore pressure. This parameter is of interest in the case of a Minimum excess pore pressure consolidation
analysis, where all pore pressures are specified to reduce below a predefined value.

Figure 8: Calculation progress displayed in the Active tasks window

Results

 After the calculation has finished, select the third phase and click the View calculation results button. The
Output window now shows the deformed mesh after the undrained construction of the final part of the
embankment. Considering the results of the third phase, the deformed mesh shows the uplift of the embankment
toe and hinterland due to the undrained behaviour.

Construction of a road embankment [ADV]
Results
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Figure 9: Deformed mesh after undrained construction of embankment (Phase 3)

1. Select the menu item Deformations > Incremental displacements > |Δu|.
2.  Select the menu item View > Arrows or click the corresponding button in the toolbar to display the

results arrows.
On evaluating the total displacement increments, it can be seen that a failure mechanism is developing:

Figure 10: Displacement increments after undrained construction of embankment

1. Click <Ctrl> + <7> to display the developed excess pore pressures (see Appendix F of the PLAXIS
3DReference Manual for more shortcuts). They can be displayed by selecting the corresponding option in the
side menu displayed as the Pore pressures option is selected in the Stresses menu.

2.  Click the Center principal directions. The principal directions of excess pressures are displayed at the
center of each soil element. The results are displayed in the figure below. It is clear that the highest excess
pore pressure occurs under the embankment centre.

Construction of a road embankment [ADV]
Results
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Figure 11: Excess pore pressures after undrained construction of embankment (Phase 3)

1. Select Phase 4 in the drop down menu.
2.  Define a vertical cross section passing through (0 1) and (60 1).
3.  Click the Contour lines button in the toolbar to display the results as contours.
4. Select the menu item View > Viewpoint. The corresponding window pops up.
5. In the Viewpoint window select the Front view option as shown:

Figure 12: Viewpoint window
6.  Use the Draw scanline button or the corresponding option in the View menu to define the position of the

contour line labels.
It can be seen that the settlement of the original soil surface and the embankment increases considerably during
the fourth phase. This is due to the dissipation of the excess pore pressures (= consolidation), which causes
further settlement of the soil. The figure below shows the remaining excess pore pressure distribution after
consolidation. Check that the maximum value is below 1.0 kN/m2.

Construction of a road embankment [ADV]
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Figure 13: Excess pore pressure contours after consolidation to Pexcess < 1.0 kN/m2

The Curves manager can be used to view the development, with time, of the excess pore pressure under the
embankment. In order to create such a curve, follow these steps:
1.  Click the Curves manager button in the toolbar. The corresponding window pops up.
2. In the Charts tabsheet click New. The Curve generation window pops up
3. For the x-axis, select the Project option from the drop-down menu and select Time in the tree.
4. For the y-axis, select the point in the middle of the soft soil layers (the second node (0.7 0.0 -3)) from the

drop-down menu. In the tree select Stresses > Pore pressure > p excess .
5. Select the Invert sign option for y-axis.
6. Click Ok to generate the curve.
7.  Click the Settings button in the toolbar. The Settings window will appear displaying the tabsheet of the

created curve.
8. Click the Phases button and select the phases 1 to 4 in the appearing window.
9. Rename the curve by typing Phases 1 - 4 in the Curve title cell.

10. Click Apply to update the plot.
11.  Save the chart in Output and save the project in Input.

Note: To display the legend inside the chart area right-click on the name of the chart and select the menu item
View > Legend in chart.
The figure below clearly shows the four calculation phases. During the construction phases the excess pore
pressure increases with a small increase in time while during the consolidation periods the excess pore pressure
decreases with time. In fact, consolidation already occurs during construction of the embankment, as this
involves a small time interval.

Construction of a road embankment [ADV]
Results
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Figure 14: Development of excess pore pressure under the embankment

Safety analysis

General considerations

In the design of an embankment it is important to consider not only the final stability, but also the stability
during the construction. It is clear from the output results that a failure mechanism starts to develop after the
second construction phase.
It is interesting to evaluate a global safety factor at this stage of the problem, and also for other stages of
construction.
In structural engineering, the safety factor is usually defined as the ratio of the collapse load to the working load.
For soil structures, however, this definition is not always useful. For embankments, for example, most of the
loading is caused by soil weight and an increase in soil weight would not necessarily lead to collapse. Indeed, a
slope of purely frictional soil will not fail in a test in which the self weight of the soil is increased (like in a
centrifuge test). A more appropriate definition of the factor of safety is therefore:

Safety factor =
Smaximum available

Sneeded for equilibrium

Where S represents the shear strength. The ratio of the true strength to the computed minimum strength
required for equilibrium is the safety factor that is conventionally used in soil mechanics. By introducing the
standard Coulomb condition, the safety factor is obtained:

Safety factor =
c − σntan(φ)

cr − σntan(φr )
Where c and φ are the input strength parameters and σn is the actual normal stress component. The parameters
cr and φr are reduced strength parameters that are just large enough to maintain equilibrium. The principle
described above is the basis of a Safety analysis that can be used in PLAXIS 3D to calculate a global safety factor.
In this approach the cohesion and the tangent of the friction angle are reduced in the same proportion:

c
cr

= tan(φ)
tan(φr ) = ΣMsf

Construction of a road embankment [ADV]
Safety analysis
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The reduction of strength parameters is controlled by the total multiplier ΣMsf. This parameter is increased in a
step-by-step procedure until failure occurs. The safety factor is then defined as the value of ΣMsf at failure,
provided that at failure a more or less constant value is obtained for a number of successive load steps.
The Safety calculation option is available in the Calculation type drop-down menu in the Phases window.

Define the calculation

To calculate the global safety factor for the road embankment at different stages of construction, follow these
steps:
1. In the Phases window and select Phase 1 in the Start from phase drop-down menu.
2.  Add a new calculation phase.
3.  In the General subtree, select Safety as calculation type.
4.  The Loading type is automatically changed to Incremental multipliers.
5. The first increment of the multiplier that controls the strength reduction process, Msf, is set automatically to

0.1. This value will be used in this tutorial.
6.  Note that the Use pressures from the previous phase option in the Pore pressure calculation type

drop-down menu is automatically selected and grayed out indicating that this option cannot be changed
7. In order to exclude existing deformations from the resulting failure mechanism, select the Reset

displacements to zero option in the Deformation control parameters subtree. The default values of all the
remaining parameters will be used. The first safety calculation has now been defined.

8. Follow the same steps to create new calculation phases that analyse the stability at the end of each
consolidation phase. In addition to selecting Safety as calculation type, select the corresponding
consolidation phase as the Start from phase parameter. The Phases explorer displaying the Safety
calculation phases is shown below.

Figure 15: Phases explorer displaying the Safety calculation phases
9.  Calculate the safety phases.
Note:

• The default value of Max steps in a Safety calculation is 100. In contrast to an Staged construction
calculation, the specified number of steps is always fully executed. In most Safety calculations, 100 steps are
sufficient to arrive at a state of failure. If not, the number of steps can be increased to a maximum of 10000.

Construction of a road embankment [ADV]
Safety analysis
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• For most Safety analyses Msf = 0.1 is an adequate first step to start up the process. During the calculation
process, the development of the total multiplier for the strength reduction, ΣMsf, is automatically controlled
by the load advancement procedure.

Evaluation of the results - Safety

Additional displacements are generated during a Safety calculation. The total displacements do not have a
physical meaning, but the incremental displacements in the final step (at failure) give an indication of the likely
failure mechanism.
In order to view the mechanisms in the three different stages of the embankment construction:
1.  Select the last Safety phase (Phase_8) and click the View calculation results button.
2. Select the menu item Deformations > Incremental displacements > |Δu|.
3.  Change the presentation from Arrows to Shadings. The resulting plots give a good impression of the

failure mechanisms. The magnitude of the displacement increments is not relevant.

Figure 16: Shadings of the total displacement increments indicating the most applicable failure mechanism of the
embankment in the final stage

The safety factor can be obtained from the Calculation info option of the Project menu. The value of ΣMsf
represents the safety factor, provided that this value is indeed more or less constant during the previous few
steps.
The best way to evaluate the safety factor, however, is to plot a curve in which the parameter ΣMsf is plotted
against the displacements of a certain node. Although the displacements are not relevant, they indicate whether
or not a failure mechanism has developed.
In order to evaluate the safety factors for the three situations in this way, follow these steps:
1. Click the Curves manager button in the toolbar.
2. Click New in the Charts tabsheet.
3. In the Curve generation window, select the embankment toe (the first node) for the x-axis. Select the menu

item Deformations > Total displacements > |u|.
4. For the y-axis, select Project and then select Multiplier > ΣMsf. The Safety phases are considered in the

chart. As a result, the curve of appears.
5. Set x-axis interval maximum to 1 in Chart tab.

Construction of a road embankment [ADV]
Safety analysis
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Figure 17: Evaluation of safety factor

The maximum displacements plotted are not relevant. It can be seen that for all curves a more or less constant
value of ΣMsf is obtained. Hovering the mouse cursor over a point on the curves, a box showing the exact value
of ΣMsf can be obtained.

Using drains
In this section the effect of the drains in the project will be investigated. The embankment constructions will be
redefined by introducing four new phases having the same properties as the first four consolidation phases. The
differences in the new phases are:
• The drains should be active in all the new phases.
• The Time interval in the first three of the consolidation phases (1 to 3) is 1 day. The last phase is set to

Minimum excess pore pressure and a value of 1.0 kN/m2 is assigned to the minimum excess pressure (|P-
stop|).

1.  After the calculation is finished, select the last phase and click the View calculation results button. The
Output window now shows the deformed mesh after the drained construction of the final part of the
embankment. In order to compare the effect of the drains, the excess pore pressure dissipation in node (0.7 0
-3) can be used.

2.  Open the Curves manager
3. In the Chart tabsheet double click Chart 1 (pexcess of node (0.7 0 -3) versus time). Select the displaying phases

to Phases 1-4. Close the Curves manager.
4.  Click the Settings button in the toolbar. The Settings window pops up.
5. Click the Add curve button and select the Add from current project option in the appearing menu. The

Curve generation window pops up.
Note: Instead of adding a new curve, the existing curve can be regenerated using the corresponding button in
the Curves settings window.

6. Select the Invert sign option for y-axis.
7. Click OK to accept the selected options and close the Curve generation window.

Construction of a road embankment [ADV]
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8. In the chart a new curve is added and a new tabsheet corresponding to it is opened in the Settings window.
9. Click the Phases button. From the displayed window select the Initial phase and the last four phases

(drains) and click OK.
10. In the Settings click Apply to preview the generated curve.
11. Click OK to close the Settings window. The chart gives a clear view of the effect of drains in the time required

for the excess pore pressures to dissipate.

Figure 18: Effect of drains

Construction of a road embankment [ADV]
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